
ПЛИС Altera. Часть 1: установка и
настройка среды разработки

mindstation (https://robotclass.ru/author/mindstation/)

Это первая часть цикла посвященная программируемой логике и среде

разработки Quartus компании Altera. В ней разбирается процесс получения

дистрибутива бесплатной редакции IDE Quartus. А также процесс создания

нового проекта в данной среде.

Следующая часть цикла: ПЛИС Altera. Часть 2: проектирование цифровой

схемы.

Во второй части разбирается процесс добавления к проекту новых файлов. 

Визуальное проектирование цифровой схемы.

Данный цикл статей ориентирован на работу с платой CTRL-CPLD-EPM570 на

чипе Altera Max II. Эта плата не является строго необходимой для

успешного освоения материала, так как описываемый в нем проект не

использует каких-то специальных возможностей Max II.

Для загрузки проекта в микросхему используется недорогой

программатор совместимый c Altera USB Blaster.

Шаг 1. Получение дистрибутива Altera Quartus

Внимание! В 2015 году Altera была приобретена компанией

Intel. Бренд Altera прекратил существование в июле 2018 года, 

адрес сайта altera.com теперь никуда не ведет. Новое имя Altera 

– Intel Programmable Solutions Group (PSG). Вся документация и ПО

необходимые для работы с ПЛИС Altera теперь доступны на

сайте intel.com
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Для создания проектов под ПЛИС Altera используется фирменная IDE — 

Quartus. Версий Quartus существует бесчисленное множество, и требуется

выбрать правильную под имеющуюся микросхему. Altera регулярно

выкидывает поддержку старых чипов из новых версий своего ПО. В свою

очередь, в новых версиях Quartus меняются требования к программному и

аппаратному обеспечению компьютера. Например, Quartus 13.1 является

последней версией работающий как 64-х так и 32-х разрядных системах.

Данная серия статей ориентирована на Quartus версии 13.1. Так как с одной

стороны, он не имеет специальных требований к разрядности

операционной системы. С другой — он поддерживает микросхемы серии

MAX II.

Для получения дистрибутива Quartus необходимо иметь аккаунт на сайте

intel.com или intel.ru К сожалению, в настоящее время (в декабре 2018 года) 

процедура регистрации на сайте Intel несколько затруднена. Форму

регистрации отыскать непросто. На нее можно выйти только на

заключительном этапе загрузки дистрибутива. Также, в процессе

регистрации Вам понадобится предоставить действующий адрес

электронной почты, номер сотового телефона и обязательно придумать

сложный пароль.

Пока идет активный процесс слияния Intel и Altera лучше воспользоваться

сторонними ресурсами для загрузки Quartus. Дистрибутив выложен в

общий доступ на Yandex-диск, ссылка для загрузки: 

https://yadi.sk/d/bcrz7IAAKY6dQg (https://yadi.sk/d/bcrz7IAAKY6dQg)

Для работы с микросхемой MAX II потребуется сам Quartus, и пакет для

поддержки MAX II и MAX V. Это файлы «QuartusSetupWeb-13.1.0.162.exe» и

«max_web-13.1.0.162.qdz» соответственно.

В конце статьи доступна и старая версия инструкции по загрузке

дистрибутива: (Архив) Получение дистрибутива Altera Quartus

(http://robotclass.ru/articles/fpga-quartus-setup/#archive). По ней можно

получить примерное представление о том, как загрузить дистрибутив с

сайта intel, так как на сайте Intel используется Software Selector от Altera. И
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также как у Altera, Software Selector перенаправляет пользователя на

страницу входа при попытке скачать любой файл, в случае если

пользователь предварительно не зашел на сайт со своей учетной записью.

Данная страница входа — единственное место, которое содержит ссылку

на форму регистрации на сайте Intel. Ссылки для регистрации

располагаются в правой части страницы. Для рядовых пользователей

можно использовать ссылку «Register now for an individual account

(https://www.intel.com/content/www/us/en/forms/fpga/fpga-individual-

registration.html)». Ссылка обозначена на рисунке ниже.

Шаг 2. Установка Quartus II Web Edition 13.1

Установка САПР Quartus II не таит каких-либо сюрпризов и проходит по

отработанному алгоритму «Next → Next → Finish».

Параметры установки изменять не требуется. В дальнейшем

предполагается что Quartus II был установлен с параметрами по

умолчанию.

По окончании установки среда Quartus запустится автоматически. Этот

автозапуск активирован по умолчанию.

Page 3 of 16ПЛИС Altera. Часть 1 Установка Quartus Пустой проект | Класс робототехники

12.09.2019https://robotclass.ru/articles/fpga-quartus-setup/



При первом запуске САПР Quartus будет предложено настроить отправку

телеметрии в Altera (здесь это называется TalkBack) и выбрать тип

лицензии.

Отключение или включение «TalkBack» задается галочкой «Enable sending 

TalkBack data to Altera», которая доступна и после установки Quartus через

меню Tools → Options → Internet Connectivity → кнопка «TalkBack Options…».

При запросе типа лицензии необходимо просто выбрать второй пункт: «Run 

the Quartus II software». Таким образом Вы выберете бесплатную лицензию.

На этом установка и первичная настройка ПО завершена и можно

переходить к созданию своего первого проекта.

Шаг 3. Quartus II — создание первого проекта

Первым делом создайте папку для нового проекта. Назовите ее

«firstproject».

Внимание! Путь до директории проекта не должен включать

кириллических символов! С поддержкой кириллицы у Quartus II 

15 и 13 версии имеются проблемы. Другие версии не

тестировались.

Теперь запустите Quartus II. При запуске свежеустановленного Quartus II 

Вас встретит окно, вид которого представлен ниже. 
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По центру окна приводятся ссылки для быстрого доступа к некоторым

функциям среды и основным разделам сайта Altera.

Для создания нового проекта воспользуйтесь мастером доступным по

кнопке «New Project Wizard» или через меню File → New Project Wizard.

При запуске мастера будет выведено окно, в котором представлено

краткое перечисление параметров проекта, настраиваемых в процессе

работы мастера.

Нажмите «Next» и будет выполнен переход к окну представленном на

скриншоте ниже. В этом окне необходимо указать рабочую директорию

(«What is the working directory for this project?») и название всего проекта в

целом («What is the name of this project?»). А также имя его главного модуля

(«What is the name of the top-level design entity for this project? …»).
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В качестве имени главного модуля мастер автоматически подставляет

название проекта и это общая рекомендация для проектов в Quartus II, от

которой не стоит отклоняться без реальной необходимости.

Пара слов о самом «главном модуле». Проект Quartus II может включать в

себя множество файлов (модулей) описывающих различные

функциональные блоки проектируемой интегральной схемы. И среди

этого множества обязательно выделяется один файл, в котором

описываются взаимосвязи между всеми блоками схемы — top-level design 

entity. Для небольших проектов, содержащих всего один файл, этот

единственный файл будет являться и главным модулем проекта.

На следующемшаге мастер предложит добавить в новый проект файлы из

каких-либо ранее созданных проектов. Так как это первый Ваш проект, то

просто перейдите к третьему шагу.
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Третий шаг один из самых важных. Здесь необходимо указать конкретную

модель используемой Вами микросхемы ПЛИС. Окно мастера на данном

шаге представлено на скриншоте ниже. В этом окне доступно множество

параметров для поэтапного отбора необходимой микросхемы из

обширного списка доступных. Начать лучше всего с блока «Device Family». 

Здесь нужно выбрать семейство к которому относится Ваш чип. На плате

CTRL-CPLD-EPM570 установлен чип EPM570T100C5N, который относится к

семейству Max II.

В блоке справа – «Show in ‘Available devices’ list», можно настроить фильтр для

сокращения перечня микросхем, который располагается в нижней части

окна. Можно указать тип корпусировки микросхемы. Количество выводов

ее корпуса. А также скорость работы ядра в условных единицах. 

Предпоследним идет фильтрация по названию микросхемы. Удобнее всего

будет использовать именно её, так как название микросхемы уже точно

известно. Но по маркировке EPM570T100C5N никаких микросхем к выбору
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не предлагается. Сократите название до EPM570T100C5, и выберите в

появившемся списке микросхему с этим названием как ближайшую

совместимую.

Если обратится к даташиту, то выяснится что последняя буква N в

маркировке микросхемы обозначает лишь отсутствие свинца в упаковке

чипа. Данный факт не имеет значения для Вашего проекта в Quartus II так

как ядро у EPM570T100C5N и EPM570T100C5 абсолютно идентично.

Перейдите к следующему, четвертому шагу – «EDA Tool Settings». Здесь

можно настроить интеграцию с различными средствами

автоматизированного проектирования от сторонних разработчиков, 

которые используются профессиональными проектировщиками

микросхем. Так как целью этой статьи является помощь в освоении САПР

Quartus II, а не целого пакета приложений стоимостью многие тысячи

долларов, то просто перейдите к заключительному шагу.
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На последнем шаге выводится обобщенный список параметров Вашего

нового проекта. Проверьте чтобы были верно заданы такие параметры

как: имя и рабочая директория проекта, top-level design entity, маркировка

используемой микросхемы. После чего нажмите кнопку «Finish». На этом

все! Проект создан.

Возможно, Вы обратили внимание что кнопка «Finish» доступна для

нажатия уже с первого шага мастера. И ее действительно можно нажать

уже на первом шаге, задав только рабочую директорию, имя проекта и

главного модуля. Только эта информация является абсолютно

необходимой для создания нового проекта. Все остальные параметры

доступны для настройки в любое время, из главного меню программы. Так, 

чтобы добавить еще файлов в свой проект (второй шаг мастера) 

используйте меню Project → Add/Remove Files in project. Для выбора или

изменения модели микросхемы под которую создается проект (третий шаг

мастера) используйте меню Assignments → Device. Интеграция с

дополнительными инструментами разработки (предпоследний шаг

мастера) – это Assignments → Settings → EDA Tool Settings.

Вообще, все настройки проекта собраны в окне, вид которого представлен

на скриншоте ниже. Окно вызывается через меню Assignments → Settings.
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Пункт Files – именно это окно вызывается и из главного меню программы

(Project → Add/Remove Files in project). EDA Tool Settings – аналогично. Выбор

микросхемы доступен по кнопке «Device…» в правом верхнем углу окна

настроек проекта.

На этом первая часть статьи по обучению работе с ПЛИС компании Intel 

(Altera) завершается.

Следующая часть цикла: ПЛИС Altera. Часть 2: проектирование цифровой

схемы (http://robotclass.ru/articles/fpga-scheme-create/).

(Архив) Получение дистрибутива Altera Quartus

Для получения дистрибутива Quartus зайдите в свой аккаунт myAltera на

сайте altera.com: кнопка «LOG IN» в правом верхнем углу сайта, рядом со

строкой поиска.
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(http://robotclass.ru/wp-content/uploads/2018/04/ПЛИС-Altera-Рис-10-MyAltera-

button.png)

Если у Вас еще нет аккаунта myAltera, то Вы можете создать его просто

перейдя по ссылке в самом низу формы регистрации, строка «Don’t have an 

account? Create one».

После входа в myAltera перейдите в центр загрузки сайта. Ссылка на

момент написания: https://www.altera.com/downloads/download-center.html

(https://www.altera.com/downloads/download-center.html)

Если ссылка окажется нерабочей, то перейдите в центр загрузки через

домашнюю страницу своего аккаунта. Для этого выберите раздел

«SUPPORT» и в нем перейдите по ссылке «Downloads», которая и приведет

Вас в центр загрузки.
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(http://robotclass.ru/wp-content/uploads/2018/04/ПЛИС-Altera-Рис-1-переход-в-

центр-загрузки.png)В центре загрузки есть прямые ссылки на загрузку

последней версии Quartus в различных редакциях. Ниже располагается

блок «Software Selector», прокрутите страницу до него.

Page 12 of 16ПЛИС Altera. Часть 1 Установка Quartus Пустой проект | Класс робототехники

12.09.2019https://robotclass.ru/articles/fpga-quartus-setup/



(http://robotclass.ru/wp-content/uploads/2018/04/ПЛИС-Altera-Рис-2-Software-

Selector.png)В Software Selector реализовано несколько способов выбора

необходимого дистрибутива Quartus, вкладки: «Select by Version» (прямой

выбор по требуемой версии ПО), «Select by Device» (выбор версии ПО по

наличию поддержки конкретной микросхемы), «Select by Software» (выбор

программного продукта по его названию).

Наиболее удобным вариантом представляется выбор по наличию

поддержки имеющейся микросхемы.

Например, если используется микросхема Altera Max II, то необходимо

выбрать вкладку «Select by Device», и в блоке «Devices» раскрыть пункт «MAX 

series». В появившемся списке выбрать Max II.
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(http://robotclass.ru/wp-content/uploads/2018/04/ПЛИС-Altera-Рис-3-Select-Web-

by-Device.png)Справа от блока Devices будет выведен список редакций и

версий Quartus включающих поддержку Max II. Бесплатной редакцией

является только Web Edition.

При выборе версии обратите внимание на тот факт, что Quartus II начиная с

версии 14.0 работает только в 64-битных системах. По этой причине

рекомендую остановится на Quartus II 13.1.  Далее будет описана работа и

процесс установки именно для тринадцатой версии.

После выбора версии Вы перейдете на страницу параметров загрузки

дистрибутива Quartus II Web Edition.
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(http://robotclass.ru/wp-content/uploads/2018/04/ПЛИС-Altera-Рис-4-Direct-

Download-parametes.png)

Рекомендуемые параметры для загрузки приведены на скриншоте выше.

«Operating System» — Windows.

«Download Method» выбирайте по своему усмотрению. Отличие «Akamai 

DLM3 Download Manager» от «Direct Download» в том, что в первом случае

перед загрузкой файлов самого Quartus нужно будет сначала загрузить и
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запустить дополнительное приложение под ОС Windows. Это приложение

позволяет выбрать к загрузке одновременно несколько файлов, а также

поддерживает их докачку. При выборе режима загрузки «Direct Download»

файлы можно будет загружать отдельно, каждый по своей ссылке, силами

Web-браузера.

На скриншоте выше выбран вариант загрузки «Direct Download».

Загрузите файлы «Quartus II Software» и «MAX II, MAX V device support». Это

необходимый минимум для работы с микросхемой MAX II.
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